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1. Description 

KGS Scan is a robust scan client that can be controlled directly in SAP to implement various storage 

scenarios. KGS Scan supports ‘early archiving’ and ‘late archiving’ in SAP. It also seamlessly inte-

grates with the KGS ZADOC and KGS ScanServer products. 

2. Scanning 

2.1 Scan Profiles 

There are various configuration parameters you can use to make the program’s behavior and the 

results of scan procedures meet the specific needs of your scanning workstation. For easy manage-

ment of these parameters, you can combine and store them in scan profiles. This enables you, for 

example, to specify the scanner to be used, how documents to be scanned will be processed, and 

how barcode recognition will be performed. 

If multiple scenarios have been configured, select the desired profile before scanning. 

 

 

 

2.1.1 Scanning a Page 

Depending on the selected profile, you can scan pages on a physical scanner or from the file system. 

When scanning via a physical scanner, place the documents into the feeder and press ‘Scan All’ to 

scan all pages: 
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If you want to scan individual pages, use the ‘Scan Page’ option: 
 

 
 
Note: Only a select few scanners equipped with a roller-based feeding system 
can scan single pages without immediately feeding part of the following page. 
Therefore, when using such a scanner, it is likely that part of the second page will 
also be fed. It is not possible to turn off this scanner behavior from the software 
side. 

 

Depending on the configuration, you will either be requested to specify the scan folder (if you are 

about to scan documents directly from the file system) or scanning will start automatically. The spe-

cific behavior depends on the settings chosen by the profile administrator during system configura-

tion. 

 

Note: The name applied to a document (e.g. ‘Document_0001_...’) also depends on previously 

made profile settings. 

 

The processing time is mainly determined by the configured image processing options and the num-

ber of pages to be scanned. 
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You can manually add pages to previously scanned documents. There are three ways to do so: 

 

2.1.1.1 Via drag & drop 

If you want to import a TIFF file, you can drag & drop the pages of this document to 

any location on a previously scanned document. Simply drag the document to the 

desired place 

 

 
 

2.1.1.2 Via the shortcut menu 

If you want to add pages to a previously scanned document from a location outside your file system 

(or in a format other than TIFF), use the shortcut menu. Select a page after which you want to attach 

the newly scanned pages. First, right-click the respective page. 
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Now select the ‘Add Page(s)’ option. The scanner defined in the profile will be used. If there are 

multiple pages in the scanner feeder, all pages will be attached to the selected page. For more in-

formation on the shortcut menu, read section 3. Shortcut Menus. 

2.1.1.3 Via the global ‘Open File’ dialog 

 

 

 
 

 

This allows you to attach a PDF or TIFF document from the file system to the previously scanned 

batch. A file selection dialog is called up. Select the file you want to import. 
 

Note: The pages will be attached to the last page of the document. 



 

  
© 2019 KGS Software GmbH Version 2.3.07 Page 8 of 28 

You can then change the order of the pages using drag & drop. 

2.1.2 Entering Index Values 

If your scan profile contains configured index fields (for instance for the ‘late archiving with barcode’ 
SAP scenario), an extra window will be shown on the right side of the panel during export. You can 
use the arrow button 
 

 
 

to expand or collapse it (if there are index fields). If the system is configured to require manual 

confirmation of index values before exporting (this can be set in the profile), the window will expand 

automatically. Use the Enter key to confirm the visible index values. 

 

 
 

In addition to the ‘Conformation required’ option, the field properties 

 
• Invisible, 

• Just Read or 

• Allow Blank Value 

 

may have been configured in the profile. 

 
Besides normal text, the profile administrator can also configure selection lists and date indications. 
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In this example, three visible index fields have been defined. The ‘Value OK’ status indicates that 

the currently selected index field contains a valid entry. 

 

3. Shortcut Menus 

The shortcut menus were overhauled in Version 1.40, and several items were added. In ge-

neral, there are three different types of shortcut menus. 

3.1 ‘Shortcut Menu ‘Thumbnail Preview’ 

 
The ‘Thumbnail Preview’ shortcut menu currently contains ten options and can be accessed by right-

clicking any page in the thumbnail preview. 

 
If you want to select multiple pages, press and hold the CTRL key while selecting pages or by cap-
turing the desired pages in a frame. 
 
 

1. Add Page(s) 

2. Delete Page(s) 

3. Re-scan Page 

4. Move Pages to new Docu-

ment 

5. Resort Page(s)  

6. Save selected Page(s) 

7. E-Mail 

8. Print Page(s) 

9. Post Processing 
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10. Properties 
 

 

3.1.1 Add Page (s) 

Refer to section 2.1.1 Scanning a Page – Via the shortcut menu. 

3.1.2 Delete Page (s) 

The selected pages are deleted without prompting and are removed from the preview. 

3.1.3 Re-scan Page 

Unless you are scanning from hard disk, you can rescan pages. The chosen page is rescanned, and 

the result replaces the previous preview image. If you are importing from the file system (using the 

File Importer), this item will be grayed out (see image). 

3.1.4 Move Pages to new Document 

If multiple pages were scanned, all marked pages are moved into a new document. This procedure 

allows you to manually enforce a document separation. 
 

3.1.5 Resort Pages 

When you select this option, you will be prompted to enter an integer value in a separate dialog. If 

the entered number is valid, KGS Scan will sort all scanned pages according to the number of pages 

indicated. 

 
Note: As this option also affects index fields, document generation and other factors, processing 

may take a while depending on the number of pages/documents involved. We therefore recom-

mend you only use this option for scenarios you cannot structure in any other way. 
 

3.1.6 E-Mail 
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KGS Scan supports e-mail integration with Outlook and Lotus Notes. If one of these programs is 

installed locally, you can send selected pages via e-mail. Here, you can choose to mail them as 

several single-page PDFs or one multi-page PDF. So in this example, either three one-page PDF 

documents or a single 3-page PDF document will be attached to the e-mail. 

 
KGS Scan generates the file names, which cannot be changed. 
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Note: You may need to adjust the sender address in the ‘FROM’ address field since third-party 

programs (in this case KGS Scan) might not be permitted to access local Outlook or Lotus 

Notes accounts for security reasons. 

3.1.7 Print Page (s) 

Use this menu item to print selected pages before exporting them. 

3.1.8 Post Processing 

 
This shortcut menu item has two submenus: 

 
• Rotate Page(s) 
 

 
 

 

Use ‘Rotate page (s)’ to rotate pages in the main or thumbnail preview. 

 

• Delete Blank Pages (s)  
 

 
 

This menu item allows you to search the current document (that contains the selected page) or all 

documents for empty pages and remove them. 
 

3.1.9 Properties 

When you choose this menu item, the program lists all key properties of the selected page. Example: 
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3.2  Shortcut Menu ‘Document Preview’ 

The ‘Thumbnail Preview’ shortcut menu currently contains six options and can be accessed 

by right-clicking any page or combination of pages in the thumbnail preview. 
 

 
 
 

1. Export 

2. Delete Dokument Seperation  

3. Email selected Document (s)  

4. Delete Blank Page (s) 

5. Print selected Docu-

ment(s) 

6. Save Document(s) 
 

 
 
 
 
 
 

3.2.1 Export 

This selection menu enables you to export the current document (just the one you right-

clicked) or all selected documents 
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3.2.2 Delete Dokument Seperation  

If you have selected multiple documents, you can use the ‘Delete Dokument Separation’ menu item 
to merge the selected documents. 
 

3.2.3 Email selected Document (s)  

If Microsoft Outlook or Lotus Notes is installed on the workstation, this option will cause the corre-

sponding program to launch while displaying the note “Compose new message” on screen. The 

attachment of the new mail contains the selected documents in PDF format. 
 

 

3.2.4 Delete Blank Page (s) 

Refer to section 3.1.8 Post Processing 

3.2.5 Print selected Documents 

After selecting this menu item, every page of each selected document will be printed. 

3.2.6 Save Document(s) 

 

 
 

This option allows you to locally store the selected documents before starting 
the export. You can choose the storage location via a ‘Save as’ dialog. 

3.3 Shortcut Menu ‘Page Preview’ 

The main view (‘Page Preview’ tab) shows the currently selected page. Right-click to open 

the corresponding shortcut menu, which provides six options: 
 

 
 
 

1. Rotate/Flip 

2. Scrollbars 

3. Copy to Clipboard 
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4. Zoom 

5. Mouse Mode  

6. Viewer Quality 

 

3.3.1 Rotate/Flip 

This option allows you to rotate or mirror the page. 

3.3.2 Scrollbars 

If this checkbox is disabled, no scroll bars will be shown; i.e., you need to use the mouse 

wheel to perform zoom operations. 

3.3.3 Copy to Clipboard 

Use this option to save the current page to the clipboard and insert it (e.g. in Microsoft Word 

or Outlook) somewhere external to KGS Scan. 

3.3.4 Zoom 

Use this menu item to change the zoom factor of the display. As an alternative, you can 
perform the same action using the mouse wheel or the toolbar. 
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3.3.5 Mouse Mode 

The selection menu enables you to change how the area around the mouse pointer is displayed. 
 

 

 

3.3.6 Viewer Quality 

This menu provides options for controlling the visual quality. 

4. Interface and Customizations 

4.1 Toolbar 
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The toolbar includes all key functions. The contents change depending on the active tab and scan 

state. 

4.1.1 Start 

 

 
 
The Start tab provides all basic functions and allows you to change the profile as long as you have 

not yet commenced scanning. 
 

4.1.2 View 

During scanning, the program automatically opens the ‘View’ tab. 

 

 

 

4.1.3 Edit 

 
This is where profile administrators can create and modify profiles as long as no scan process has 

been performed. Else, this item is grayed out. 

 

 
 

4.1.4 Window 

Please refer to section 6 Windows and Docking Panels. 

4.1.5 About 

 
This tab provides an overview of key information about the program. This includes, in particular, 

licensing management data required by IT administrators. 
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4.1.6 Loading Files from Disk 

If a profile administrator configured the ‘FileImporter’ profile or some other parameters (see the KGS 

Scan installation and configuration manual), the way the other profiles are displayed may differ (de-

pending on the combination of defined parameters).  

4.2 Function Keys 

4.2.1 Scan All 

Refer to section 2.1.1 Scanning a Page. 

4.2.2 Scan Page 

Refer to section 2.1.1 Scanning a Page. 
 

4.2.3 Delete All 

If you click this button, all previously scanned documents are deleted, and the preview and main 
panel are cleared. Now the system is ready to perform a completely new scan. 

If you already exported individual documents, now the batch is released for downstream processing 

by other programs or services such as KGS Scan Transfer. 

4.2.4 Rescan Page 

Unless you are scanning from hard disk, you can rescan pages. The chosen page is rescanned, and 

the result replaces the previous preview image. If you are importing files from hard disk (using the 

File Importer), this item is grayed out. 

4.2.5 Export 

This selection menu allows you to export all documents or selected ones. 
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4.2.6 Zoom In 

 

 
 

 

Zooms to the next higher level on the current page. 
 

4.2.7 Dropdown Selection 

Provides predefined zoom options. 

4.2.8 Zoom Out 

Zooms to the next lower level on the current page. 

 

4.2.9 Rotate/Flip 

This option allows you to rotate or mirror the preview page. 
 
 

•                               

 

4.3 Status Bar 

The status bar is located at the bottom of the KGS Scan interface panel. 
 

 
 

The first field (‘de’ in this screenshot) shows the current language. You can change it in the 

Options -> Language menu. 

For more information on this topic, see section 5.1.2 
Language. 
The second field displays the memory load (in mega-
bytes) of the currently used thread. The fourth column 
indicates the number of documents scanned so far. The 
next column shows the number of pages scanned up to 
now. 
The sixth column shows the name of the profile currently in use. 
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The seventh column indicates the current status to alert you to issues or provide information 
(for example, ‘duplicate barcode’ or the status ‘waiting for SAP user interaction’). 
If a scan server has been configured in the scan profile as the export target, the eighth column 
displays the status of the transfer folder in C:\ProgramData\KGS Scan\Transfer. 
If the LED is green, there are no documents in this folder; i.e., previously exported documents 

were properly picked up by the KGS Scan transfer service and transferred to the scan server. 

If the LED is yellow, there are still documents in the transfer folder. In this case, please contact 
your system administrator. 

 

5. Global Settings 

KGS Scan offers several options for defining individual settings that apply to the local workstation. 

These local settings are stored, so they will be available every time the program is started. 

 

Click the blue drop-down button to perform this action.  

 

 
 

5.1 Open File 

See the global dialog "Open file". 

5.2 Save Session  

If documents were already scanned, this button becomes active. It allows you to export the current 

status (scanned documents, index fields etc.). The generated ZIP file contains all data required to 

restore a so-called session (work status).  

5.3 Load Session 

If there is a stored work status, you can use the ‘Load Session’ option to restore saved sessions. 

This is only possible if all current documents were processed/exported. 

5.4 Options 

This item provides global options. 

The global settings comprise four menu items that are explained below. 
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5.4.1 General 

The General section provides system administrators with options for configuring an op-

tional scan server. For more detailed information on this topic, please refer to the ‘KGS 

Scan Server Installation and Configuration Manual’. 

The ‘Session Handing’ option allows you to decide how the system behaves when the KGS 

Scan session ends. By default, the ‘Save Working State’ checkbox is enabled. This means 

that all documents that have not yet been processed when KGS Scan is closed will be 

saved locally. Locally stored documents are automatically loaded the next time you launch 

KGS Scan. When doing so, the program will account for any existing profile groups. If you 

remove the checkmark, documents not yet processed will be ignored next time the program 

is started. 

 

5.4.1.1 Saving the Work Status when Exiting the Program 

By default, the ‘Save Working State’ checkbox is enabled. This means that all documents that have 

not yet been processed when KGS Scan is closed will be saved locally. Locally stored documents 

are automatically loaded the next time you launch KGS Scan. When doing so, the program will ac-

count for any existing profile groups. If you remove the checkmark, documents not yet processed will 

be ignored next time the program is started. 

5.4.1.2 Save Indexframe State when Exiting the Program 

The ‘Save Indexframe State when Exiting the Program’ checkbox is unchecked by default. If you 

check it, the status of the index panel (closed or open) will be restored when starting KGS Scan. If, 

for example, the panel was open when you quit the application, it will be open the next time you 

launch the program again. 

 

 

5.4.2 Language 

At present, KGS Scan supports German and 

English. If you enable ‘Auto Detection’, the 

language defined on the operating system 

level will be adopted. 

 
The language setting affects both the interface 

and the configurations. 
 
 
 

 

5.4.3 SAP 

 
This configuration section currently only 
provides a single configuration item: ‘Min-
imize (OLE Export)’. 
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If you enable the checkbox, the KGS Scan 

window is minimized after a successful 

SAP OLE export. 
 
 
 
 

5.4.4 GUI Customizing 

The ‘ GUI Customizing’ section enables you to change various font sizes as well as the size 
of thumbnail preview images. 

You can presently change the following font sizes: 

• Index field name (field label) 

• Index field value (value box) 

• Document name 

Expand the corresponding category in the tree view, select the field whose font size you want to 

change, and use the slider below to make the adjustment. Changes are applied instantly. 

Once you are done, save the changes. 
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In order to change the size of the thumbnail images, either select one of the three predefined values 
(64x64, 72x72 or 96x96) or specify a custom value under ‘User Defined’. 

 
Note: KGS Scan will calculate the height and width in relation to the scanned document. As a result, 

for instance when viewing an A4 page at the selected thumbnail size of 64x64 pixels, the dimen-

sions actually shown are (64÷1.4) x 64 pixels = 45 x 64 pixels. 
 

5.5 Global Shortcut Keys 

Function keys and shortcut keys allow you to quickly perform routine actions. The following shortcut 

keys are available: 
 

• 

• 

• 

• 

• 

• 

 Left 

Right 

Up 

Down 

Del 

Page up 

Move to the left (thumbnail preview) 

Move to the right (thumbnail preview) 

Move up (thumbnail preview)  

Move down (thumbnail preview) 

Delete page 

Go to the first page of the previous document 

• Page down Go to the first page of the next document 

• Home Go to the first page of the first document 

• End Go to the first page of the last document 

• F6 Export current document 

• F7 Export selected documents 

• F8 Export all documents 

• F9 Start scanning (all pages) 

• F10 Start scanning (single page) 

• F11 Remove all pages 

• F12 Rescan selected page 

• CTRL + A Select/Deselect all pages 

• CTRL (hold) + Click (page) Add page to selection 

• CTRL + M Move selected pages to a new document 

• CTRL (hold) + Click (document) Add document to selection 

• CTRL + C Add page to the Windows clipboard 

• CTRL + V Paste page from the Windows clipboard 

 

6. Windows and Docking Panels 

KGS Scan can swap out individual window sections. This feature is implemented using a so-called 

docking panel. If you want to rearrange certain windows, click and hold, for instance, the ‘View’ tab 

and pull the tab to any other location. 
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Now you should be seeing blue docking areas. Release the window in one of these blue areas. A 

light blue preview will show you what the current arrangement will look like if applied. 

You can manipulate the following window elements using this feature: 

 
• Thumbnail preview 

• Profile information 

• Preview 

• Extended profile info  

• Barcode table (for duplicate alerts) 

 
You cannot dock the indexer, toolbar or the status bar. 
Note: You can apply the same method to swap out window sections to a second screen (for example 
in full-screen mode). 
 
Here are some examples: 
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... or, when swapped out: 
 

 
 

You can generally rearrange all elements listed above. 

 
Use the ‘Window’ tab to individually enable or disable the different window sections 
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As an alternative, use the ‘x’ button at the top right of the window to disable a window. 

Note: ‘Barcode Table’ is only shown if barcode processing has been configured for the correspond-

ing profile. This section alerts users to duplicate barcodes and highlights duplicate codes in the same 

color. 

7. Window Description 

Preview: 

 
The preview window fully displays the page selected 

in the thumbnail preview. Depending on the zoom 

level, there will be vertical and/or horizontal scroll 

bars for moving the visible area of the page. 

Further options are detailed in section 3.3 Shortcut 

Menu. 
 

 

7.1 Thumbnail Preview 

 
The thumbnail preview provides an overview 

of all scanned documents. 

 
In addition to supporting standard drag & drop 

operations, it also has a shortcut menu. For 

more information on this type of menu, please 

refer to 3.1 ‘Thumbnail Preview’ Shortcut 

Menu and 3.2 Shortcut Menu. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7.2 Profile Info 

The ‘Profile Info’ window shows key details of the cur-

rently selected scan profile. 

The fields are read only, so they serve the sole pur-

pose of providing you with information. 
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7.3 Barcode Table 

The barcode table lists all barcodes de-

tected for the entire stack (if it was ena-

bled in the profile). If any two barcodes 

are identical, they are color coded. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7.4 Profile Info Extended 

The ‘Profile Info Extended’ window dis-

plays all parameters set in the profile. 

This window is disabled by default, but 

you can enable it via Window → Ex-

tended Profile Information. 

The categories precisely match the pro-

file tabs. Double-click the category or 

use the buttons to extend or hide them. 
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7.5 Reset the Layout 

If you want to reset the layout for any reason, you can do so using this option. Once configured, KGS 

Scan will restart to apply the changes. 

 

 

 


